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This help file contains information that you might find useful when first installing WinZip®.    Just click on 
any of the topics below.
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If you are looking for the main help on how to use WinZip, click one of these two topics:

WinZip Wizard help

WinZip Classic interface help



WinZip Installation
The Setup Wizard will guide you through the simple WinZip installation procedure.

The Wizard will ask a few questions during setup.    Most users can simply accept all of the recommended
settings by clicking Next.    Advanced users can customize installation by changing options as they 
appear.

If you are interested in information on installing WinZip site licenses in a networked environment, please 
see the web page http://www.winzip.com/site_install.htm.



Printing the Quick Start Guide
The Quick Start Guide provides valuable information to help you get started using WinZip®.    To print the 
Guide, click Print Quick Start during the installation process.

In the Print dialog,
· Use the Name dropdown list to select the printer you want to use.
· Click Properties to change printer settings such as print quality and paper type.
· Click OK to print the Quick Start Guide, or Cancel if you do not want to print it.

After installation, you can view the Quick Start Guide at any time by clicking Help on any Wizard panel, 
clicking the help Contents button, and then clicking The WinZip Quick Start Guide. 



The Wizard and Classic Interfaces

The two WinZip® interfaces
WinZip can be used with two different interfaces: the WinZip Classic interface or the WinZip Wizard.    
Both interfaces are included in all versions of WinZip.    One click switches from the Wizard to the Classic 
interface and vice versa.

· The WinZip Wizard interface is ideal if you want to know as little about Zip files as possible or to 
just "get started" with the files you have downloaded.    With the Wizard, you simply click the 
"Next" button a few times, and presto, your files are zipped, unzipped, or installed.    When you 
want to use more advanced zipping features, you can easily switch to the Classic interface.

· The award-winning WinZip Classic interface features tight integration with the Windows 
95/98/NT/2000/Me/XP shell and versatile drag and drop facilities. It is great if you are comfortable
using Windows and the Explorer, or want to use advanced zipping features.

When you install WinZip you must choose which interface WinZip will use when it starts up.    But 
whichever you choose, remember that you can always change your mind later and that it is easy to switch
interfaces any time.
How do I …



· choose a WinZip interface?

· switch interfaces while I'm using WinZip?

· change the interface WinZip will use when it starts up?



How do I choose a WinZip interface?
During the WinZip setup procedure you are asked to select either the WinZip Wizard interface or the 
WinZip Classic interface.

Look at these two lists and decide which one seems more like you:

You might prefer the Wizard if
· you are new to computers.
· you are unfamiliar with the Windows operating system.
· you don't know much about Zip files, and don't want to.
· you just want to be able to deal with downloaded archives with a minimum of fuss.

You might prefer the Classic interface if
· you are an experienced computer user.
· you are comfortable using Windows and Zip files.
· you know how to use Windows Explorer.
· you need finer control over what goes into your Zip files, and what happens to files after they've 

been zipped.

Whichever one you choose, remember that you can always switch interfaces any time or change the 
interface WinZip uses when it starts up.



How do I switch interfaces while I'm using WinZip?

Whichever interface you're using, the other interface is always just one click away.

To switch from the WinZip® Wizard to the Classic interface

While in the Wizard, switch to the Classic interface by clicking on the WinZip Classic button.



To switch from the Classic interface to the WinZip Wizard

While using the Classic interface, switch to the Wizard by clicking on the Wizard toolbar button, or choose
the Wizard entry in the File menu.



How do I change the interface WinZip will use when it starts?
Naturally enough, WinZip® must always start up using one of the two interfaces, either Classic or the 
Wizard.    You have to pick one of these when you install WinZip, but it's easy to change your mind later.    
Here's how:
To start up in the WinZip Wizard

· If you're currently using the Classic interface:
1. Choose Configuration from the Options menu.
2. Click the Miscellaneous tab.
3. Check the Next time start with the Wizard interface checkbox.
4. Click OK.

· If you're currently in the WinZip Wizard:
1. If necessary, click Next or Back to get to the Welcome to WinZip panel.
2. Click Options and then click on the Misc tab.
3. Click Next time start WinZip with the Wizard interface.
4. Click OK.

To start up in the Classic interface
· If you're currently using the Classic interface:

1. Choose Configuration from the Options menu.
2. Click the Miscellaneous tab.
3. Uncheck the Next time start with the Wizard interface checkbox.
4. Click OK.

· If you're currently in the WinZip Wizard:
1. If necessary, click Next or Back to get to the Welcome to WinZip panel.
2. Click Options and then click on the Misc tab.
3. Click Next time start WinZip with the Classic interface.
4. Click OK.

Tip: there's an even easier way to change your startup interface: just switch interfaces to the one you 
want to use at startup and then close WinZip.    WinZip will display a dialog asking you to pick the 
interface to use next time; simply click the button for the desired interface.



The WinZip Quick Start Guide
The WinZip® Quick Start Guide provides helpful information about getting started with WinZip.    You can 
print or view the Quick Start Guide from this panel.

Click Print Quick Start to print the Quick Start Guide.

Click View Quick Start to view the Quick Start Guide using Windows help.

Click Next when you are ready to continue.



Printing the Quick Start Guide
The Quick Start Guide provides valuable information to help you get started using WinZip®.    To print the 
Guide, click Print Quick Start during the installation process.

In the Print dialog,
· Use the Name dropdown list to select the printer you want to use.
· Click Properties to change printer settings such as print quality and paper type.
· Click OK to print the Quick Start Guide, or Cancel if you do not want to print it.

After installation, you can view the Quick Start Guide at any time by clicking Help on any Wizard panel, 
clicking the help Contents button, and then clicking The WinZip Quick Start Guide.



Express or custom setup
You can install WinZip® using either express or a custom setup.    Your choice affects only the initial 
settings of certain WinZip options; it does not affect where WinZip will be stored or how much disk space 
is used.    Whichever you choose, you can change any option settings any time.

To continue, click either Express setup or Custom setup and then click Next.
Express installation
Express installation installs WinZip using the most commonly chosen options.    For example, WinZip is 
associated with archives, and WinZip icons are placed in the Start menu and on your desktop.    Express 
installation is easiest and best for most users.

Custom installation
The custom installation, recommended for advanced users only, allows you to tailor initial WinZip option 
settings to your needs.



Explorer configuration
The Explorer Configuration panel allows you to select which optional Explorer-related WinZip® features 
you would like to enable.    Simply check the options you want and click Next.
The options are:

· Associate WinZip with archives: Windows will use WinZip to open archives from My Computer, 
Windows Explorer, most e-mail programs, etc.

· Explorer shell extension: WinZip's Explorer context menus are enabled, and you can use drag 
and drop to zip and unzip without leaving Explorer.

· Display WinZip context items in a submenu: WinZip's Explorer context menu items will appear
in a submenu of the main Explorer context menu.    If unchecked, the menu items will appear in 
the Explorer menu itself.

· Display icons on context menus: a small WinZip icon is displayed to the left of WinZip's 
Explorer context menu items.

· Include WinZip Quick Pick in taskbar tray: a WinZip icon will appear in the system tray, 
providing instant access to WinZip and to recently opened archives.

· Include WinZip in Start menu: WinZip appears in the taskbar's Start menu.
· Include WinZip on desktop: a WinZip icon appears on your desktop.



Other options
The Other Options panel control a few additional WinZip® options.    Set the options as desired, then click 
Next.
The options are:

· Program Locations: a few optional WinZip operations require external programs.    These 
include operations such as virus scanning, viewing files with no Windows associations, and 
working with certain types of non-Zip archives.    You can configure these programs now by 
clicking Program Locations, or you can wait until you need them and configure at that time by 
choosing Configuration from WinZip's Options menu.

· Create WinZip program group and icons: Setup will create a window containing WinZip icons.
· Create icon for WinZip Self-Extractor Personal Edition: Setup will create an icon for the Self-

Extractor.    This program, included with WinZip, allows you to create self-extracting Zip files that 
can be unzipped by users who do not have access to WinZip or another Zip-related program.



Favorite folders
The Search for Favorite Zip Folders panel controls how Setup searches for your Favorite Zip Folders.

Favorite Zip Folders is a WinZip® feature that helps you to organize your Zip files by identifying folders on
your system that are likely to contain Zip files.    Your Zip files are then presented in one convenient list, 
making it easier to locate all Zip files, regardless of where they came from or where they are stored.

Choose the search method you prefer, then click Next.    Regardless of which option you pick now, you 
can always reorganize your Favorite Zip Folders by clicking Options from the Wizard's Welcome panel.

The options are:
· Search Entire Hard Disk: Searches all folders on your hard disk for Zip files.    This is the 

recommended option.
· Quick Search: Searches for certain specific folders that commonly contain Zip files.    This option 

is faster but not as comprehensive.



Favorite folders added
The Folders added to your "Favorite Zip Folders" panel shows how many folders have be added to your 
Favorite Zip Folders.

Favorite Zip Folders is a WinZip® feature that helps you to organize your Zip files by identifying folders on
your system that are likely to contain Zip files.    Your Zip files are then presented in one convenient list, 
making it easier to locate all Zip files, regardless of where they came from or where they are stored.

Click Next to continue with the installation.



Wizard setup complete
Congratulations!    The WinZip® Wizard is installed and ready to use.

· Click Next to start the Wizard.
· Click Close to close WinZip.

Here are some of the ways you can start WinZip in the future:
· From the Start menu, click Programs, then WinZip, then WinZip again.
· Click WinZip from the Start menu.
· Double click the WinZip desktop icon.
· Double click a Zip file in a My Computer or Windows Explorer window, or double click a Zip file e-

mail attachment.
· Drag and drop a Zip file on the WinZip desktop icon.



Installation is complete
Congratulations!    WinZip® is installed and ready to use.

· Click Finish to close WinZip Setup and start WinZip.
· Click Close to close WinZip Setup.

Here are some of the ways you can start WinZip in the future (assuming that you enabled all of the 
Explorer options):

· From the Start menu, click Programs, then WinZip, then WinZip again.
· Click WinZip from the Start menu.
· Double click the WinZip desktop icon.
· Double click a Zip file in a My Computer or Windows Explorer window, or double click a Zip file e-

mail attachment.
· Drag and drop a Zip file on the WinZip desktop icon.



Associations
Associations help Windows to know when to use WinZip with your files.    For example, because WinZip is
associated with Zip files, Windows will always use WinZip to open Zip files.    For best operation, WinZip 
should be associated with all types of archives that it supports.

Click Next to automatically associate WinZip with all supported archive types.

Click Associations if you would like to examine the associations that WinZip will create and specify 
which associations you want to enable.



WinZip 8.1 Ordering Information
The following information is for the English language version of WinZip®.    All orders are subject to the 
WinZip License Agreement.

To Order WinZip Now
To order online and download your order immediately, go to the WinZip web site at:

http://www.winzip.com/order.cgi

You can also use our web site to order copies of WinZip on CD for delivery by postal mail.

Other Ordering Options
In addition to ordering online, you can also place orders in the following ways.    These orders will be 
shipped by postal mail (airmail outside the US) and will leave our office within two business days after the 
order is received:

Credit card orders by phone

Credit card orders by fax or mail

Ordering by check

Purchase orders

WinZip Pricing
WinZip Single-User License: $29

WinZip Site Licenses:

2 to 9 computers: $22 per computer

10 to 24 computers: $17 per computer

25 to 49 computers: $14 per computer

50 to 99 computers: $10 per computer

100 to 199 computers: $7 per computer

200 to 499 computers: $6 per computer

500 to 749 computers: $4 per computer

If you need a quote for higher quantities, please send a message to sitesales@winzip.com.

There is a $5.00 per order charge for shipping and handling.    Prices are in US dollars and are 
guaranteed through December, 2002.

Site Licenses
The WinZip site license from WinZip Computing is for the English language version of WinZip.    A site 
license for WinZip entitles your organization to receive one copy of the distribution package and to 
duplicate the software as necessary for use within your organization on the specified number of 
computers.

The WinZip site license is only for use within your own organization. For example, you cannot give or sell 
any of your site-licensed copies of WinZip to your customers, or include site-licensed copies of WinZip in 
products that you sell. 

The WinZip site license is not a concurrent user license.    Each copy of WinZip may either be used by a 
single person who uses the software personally on one or more computers, or used on a single 
workstation used non-simultaneously by multiple people, but not both.

If you have further questions, please send a message to sitesales@winzip.com.



German, French, and Japanese Versions
There are German and French language versions of WinZip.    For Japanese users there is an English 
version with the Help file in Japanese.    Click here for additional information.



WinZip Standard License
WinZip® Copyright © 1991-2001 by WinZip Computing, Inc.
All rights reserved.

This license applies to the standard-licensed version of WinZip.    If you have an evaluation version of 
WinZip, see the section titled WinZip Evaluation License.

WinZip License
WinZip Computing, Inc. 
Your Agreement to this License
You should carefully read the following terms and conditions before using, installing or distributing this 
software.    Unless you have a different license agreement signed by WinZip Computing, Inc. (“WCI”) your 
use, distribution, or installation of WinZip indicates your acceptance of this agreement ("License").    

If you do not agree to all of the terms and conditions of this License, then: (a) do not copy, install, 
distribute or use any copy of WinZip with which this License is included, and (b) in addition, if you paid 
WCI or an authorized WCI reseller for a package consisting of one or more copies of WinZip, you may 
return the complete package unused, within thirty (30) days after purchase, for a full refund of your 
payment.

The terms and conditions of this License describe the permitted use and user(s) of each Licensed Copy 
of WinZip.    For purposes of this License, if you have a valid single-copy license, you have the right to use
a single "Licensed Copy" of WinZip; if you or your organization has a valid multi-user license, then you or 
your organization have/has the right to use up to a number of "Licensed Copies" of WinZip equal to the 
number of copies indicated in the documents issued by WCI when granting the license.

Scope of License
Each Licensed Copy of WinZip may either be used by a single person who uses the software personally 
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple 
people, but not both. This is not a concurrent use license.

Each Licensed Copy may be accessed through a network, provided that you have purchased rights to 
use a Licensed Copy for each workstation that will access WinZip through the network.    For instance, if 8
different workstations will access WinZip on the network, you must purchase rights to use 8 Licensed 
Copies of WinZip, regardless of whether the 8 workstations will access WinZip at different times or 
concurrently.

Each Licensed Copy of WinZip includes WinZip Self-Extractor Personal Edition, which may be used to 
create an unlimited number of freely distributable, royalty-free self-extracting Zip files. These self-
extracting Zip files contain, among other things, a portion of WinZip Self-Extractor Personal Edition, 
including copyrighted software, proprietary notices, and identifying information (the "Extraction Software").
You may not alter or modify the Extraction Software, nor permit anyone else to do so.

All rights of any kind in WinZip which are not expressly granted in this License are entirely and exclusively
reserved to and by WCI.    You may not rent, lease, modify, translate, reverse engineer, decompile, 
disassemble, or create derivative works based on, WinZip, nor permit anyone else to do so. You may not 
make access to WinZip available to others in connection with a service bureau, application service 
provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations
WinZip, and any and all accompanying software, files, data and materials, are distributed and 
provided “AS IS” and with no warranties of any kind, whether express or implied. In particular, 
there is no warranty for the optional virus scanning feature. (WinZip does not scan for viruses, it simply 
runs external programs that claim to perform this function.)      You acknowledge that good data processing
procedure dictates that any program, including WinZip, must be thoroughly tested with non-critical data 
before there is any reliance on it, and you hereby assume the entire risk of all use of the copies of WinZip 



covered by this License.    This disclaimer of warranty constitutes an essential part of this License. 

Any liability of WCI will be limited exclusively to refund of purchase price.    In addition, in no event
shall WCI, or its principals, shareholders, officers, employees, affiliates, contractors, subsidiaries, 
or parent organizations, be liable for any indirect, incidental, consequential, or punitive damages 
whatsoever relating to the use of WinZip, or to your relationship with WCI.

In addition, in no event does WCI authorize you or anyone else to use WinZip in applications or 
systems where WinZip's failure to perform can reasonably be expected to result in a significant 
physical injury, or in loss of life.    Any such use is entirely at your own risk, and you agree to hold 
WCI harmless from any and all claims or losses relating to such unauthorized use.

General
This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements.    This License shall be governed by the laws of the State of Connecticut, without regard to 
Connecticut choice-of-law rules.    Exclusive jurisdiction and venue for all matters relating to this License 
shall be in courts and fora located in the State of Connecticut, and you consent to such jurisdiction and 
venue.    There are no third party beneficiaries of any promises, obligations or representations made by 
WCI herein.        Any waiver by WCI of any violation of this License by you shall not constitute, nor 
contribute to, a waiver by WCI of any other or future violation of the same provision, or any other 
provision, of this License. 



WinZip Evaluation License
WinZip® Copyright © 1991-2001 by WinZip Computing, Inc.
All rights reserved.

This license applies to the evaluation version of WinZip.    If you do not have an evaluation version of 
WinZip, see the section titled WinZip Standard License. 

WinZip License
Evaluation Version
WinZip Computing, Inc. 
Your Agreement to this License
By using, copying, transmitting, distributing or installing WinZip 8.1 ("WinZip"), you agree to all of the 
terms of this agreement (“License”).

Please read the license terms below.    If you do not agree to all of the terms of this License, then do not 
use, copy, transmit, distribute, or install WinZip.

Scope of License
This is not free software.    Subject to the terms below, you are hereby licensed by WinZip Computing, Inc.
(“WCI”) to use one copy of WinZip, on one (1) computer or workstation, for evaluation purposes without 
charge for a period of 21 days.    If you use this software after the 21-day evaluation period a registration 
fee of $29 is required.    Payments must be in US dollars drawn on a US bank, and should be sent to 
WinZip Computing, Inc., P.O. Box 540, Mansfield, CT 06268, USA.    See the WinZip web site at 
http://www.winzip.com for information about online ordering and quantity discounts.

Unregistered use of WinZip after the 21-day evaluation period is in violation of U.S. and international 
copyright laws.

You may, without making any payment to WCI:
a) give exact copies of this evaluation version of WinZip personally to anyone, except for the 

purpose of extending their 21-day evaluation period;
b) distribute exact copies of this evaluation version of WinZip, if done exclusively through electronic 

channels; and 
c) make as many exact copies of this evaluation version of WinZip as you wish, for purposes of 

distribution as described in (a) and (b) above.

You are specifically prohibited from charging, or requesting donations, for any copies, however 
made, and from distributing such copies with other products of any kind, commercial or 
otherwise, without prior written permission from WCI. WCI reserves the right to revoke the above 
distribution rights at any time, for any or no reason.
Self-extracting Zip files created by WinZip's Self-Extractor Personal Edition component contain, among 
other things, a portion of WinZip Self-Extractor Personal Edition, including copyrighted software, 
proprietary notices, and identifying information (this portion is the "Extraction Software").    You may not 
alter or modify the Extraction Software, nor give anyone permission to do so. Under no circumstances 
are you licensed to distribute self-extracting Zip files created by the evaluation version of WinZip 
Self-Extractor.

All rights of any kind in WinZip which are not expressly granted in this License are entirely and exclusively
reserved to and by WCI.    You may not rent, lease, modify, translate, reverse engineer, decompile, 
disassemble, or create derivative works based on, WinZip. You may not make access to WinZip available 
to others in connection with a service bureau, application service provider, or similar business. 

Warranty Disclaimers and Liability Limitations
WinZip, and any and all accompanying software, files, data and materials, are distributed and 



provided “AS IS” and with no warranties of any kind, whether express or implied. In particular, 
there is no warranty for the optional virus scanning feature. (WinZip does not scan for viruses, it simply 
runs external programs that claim to perform this function.)      You acknowledge that good data processing
procedure dictates that any program, including WinZip, must be thoroughly tested with non-critical data 
before you rely on it, and you hereby assume the entire risk of using the program.    This disclaimer of 
warranty constitutes an essential part of this License. 

Any liability of WCI will be limited exclusively to refund of purchase price, if any.    In addition, in 
no event shall WCI, or its principals, shareholders, officers, employees, affiliates, contractors, 
subsidiaries, or parent organizations, be liable for any indirect, incidental, consequential, or 
punitive damages whatsoever relating to the use of WinZip, or to your relationship with WCI.

In addition, in no event does WCI authorize you to use WinZip in applications or systems where 
WinZip's failure to perform can reasonably be expected to result in a significant physical injury, or
in loss of life.    Any such use by you is entirely at your own risk, and you agree to hold WCI 
harmless from any and all claims or losses relating to such unauthorized use.

General
This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements.    This License shall be governed by the laws of the State of Connecticut, without regard to 
Connecticut choice-of-law rules.    Exclusive jurisdiction and venue for all matters relating to this License 
shall be in courts and fora located in the State of Connecticut, and you consent to such jurisdiction and 
venue.    There are no third party beneficiaries of any promises, obligations or representations made by 
WCI herein.    Any waiver by WCI of any violation of this License by you shall not constitute or contribute 
to a waiver of any other or future violation by you of the same provision, or any other provision, of this 
License. 



WinZip 8.1 Order Form/Invoice
To print this order form, select Print Topic from the File menu.
To order by check, send this completed order form and a check (in US dollars drawn on a US bank) to 
WinZip Computing, Inc., PO Box 540, Mansfield, CT 06268 USA.    

All orders are subject to the WinZip® License Agreement. Customer information is considered confidential
and will not be shared with or distributed to any third party.    This order form applies only to the English 
language version of WinZip.      Prices are in US dollars and are guaranteed through December, 2002.

WinZip Single-User License (on CD): ______ copies at $29 each = ___________

WinZip Site Licenses (includes one distribution CD):

2 to 9 computers: _____ computers at $22 per computer = ___________

10 to 24 computers: _____ computers at $17 per computer = ___________

25 to 49 computers: _____ computers at $14 per computer = ___________

50 to 99 computers: _____ computers at $10 per computer = ___________

100 to 199 computers: _____ computers at      $7 per computer = ___________

200 to 499 computers: _____ computers at      $6 per computer = ___________

500 to 749 computers: _____ computers at      $4 per computer = ___________

Add $5.00 shipping and handling + $5.00

Connecticut residents add 6% sales tax + ___________

Total payment US$ ___________

If you need a quote for higher quantities, please send a message to sitesales@winzip.com

Date: ___________________________

Name: _______________________________________________________
__

Company: _______________________________________________________
__

Address: _______________________________________________________
__

_______________________________________________________
__

City, State, Zip, Country: _______________________________________________________
__

Phone: _______________________________________________________
__

Fax: _______________________________________________________
__

E-Mail Address: _______________________________________________________



__



WinZip 8.1 Credit Card Order Form
To print this order form, select Print Topic from the File menu.
To order with a credit card by fax or mail, please complete this credit card order form and send it to:

Fax: 1-860-429-3542
Mail: WinZip Computing, Inc., PO Box 540, Mansfield, CT 06268 USA

All orders are subject to the WinZip® License Agreement.    Customer information is considered 
confidential and will not be shared with or distributed to any third party.    This order form applies only to 
the English language version of WinZip.    Prices are in US dollars and are guaranteed through December,
2002.

WinZip Single-User License (on CD): _____ copies at $29 each = ___________

WinZip Site Licenses (includes one distribution CD):

2 to 9 computers: _____ computers at $22 per computer = ___________

10 to 24 computers: _____ computers at $17 per computer = ___________

25 to 49 computers: _____ computers at $14 per computer = ___________

50 to 99 computers: _____ computers at $10 per computer = ___________

100 to 199 computers: _____ computers at      $7 per computer = ___________

200 to 499 computers: _____ computers at      $6 per computer = ___________

500 to 749 computers: _____ computers at      $4 per computer = ___________

Add $5.00 shipping and handling +  $5.00    

Connecticut residents add 6% sales tax + ___________

Total payment US$ ___________

If you need a quote for higher quantities, please send a message to sitesales@winzip.com

Date: ____________________________

Name: _______________________________________________________
___

Company: _______________________________________________________
___

Shipping Address: _______________________________________________________
___

_______________________________________________________
___

City, State, Zip, Country: _______________________________________________________
___

Billing Address: _______________________________________________________
___

(if different from above) _______________________________________________________
___

City, State, Zip, Country: _______________________________________________________
___

Phone: _______________________________________________________
___



Fax: _______________________________________________________
___

E-Mail Address: _______________________________________________________
___

Credit Card (circle one): MasterCard VISA AMEX Discover

Credit Card #: _______________________________________________________
___

Expiration Date: _______________________________________________________
___

Name On Card: _______________________________________________________
___

Signature: _______________________________________________________
___



Credit Card Orders by Phone
You can place credit card orders by phone at 1-877-724-4600 (toll free; US only), or 1-860-429-4649.

WinZip Computing, Inc. cannot be reached at the phone numbers above.    These numbers are for our 
credit card order handling service only.    If you have questions about WinZip®, or need WinZip technical 
support, you can send e-mail to help@winzip.com; our goal is to respond to all e-mail inquiries within one 
business day.

WinZip Pricing
WinZip Single-User License (on CD): $29 each

WinZip Site Licenses (includes one distribution CD):

2 to 9 computers: $22 per computer

10 to 24 computers: $17 per computer

25 to 49 computers: $14 per computer

50 to 99 computers: $10 per computer

100 to 199 computers: $7 per computer

200 to 499 computers: $6 per computer

500 to 749 computers: $4 per computer

There is a $5.00 per order charge for shipping and handling.    If you need a quote for higher quantities, 
please send a message to sitesales@winzip.com.

Your order will be shipped by postal mail (airmail outside the US) and will leave our office within two 
business days after the order is received.

All orders are subject to the WinZip License Agreement.    Customer information is considered confidential
and will not be shared with or distributed to any third party.    This order information applies only to the 
English language version of WinZip.      Prices are in US dollars and are guaranteed through December, 
2002.



Purchase Orders
Purchase orders (Net 30 days) are accepted from government and educational institutions and major 
corporations, provided that they are submitted on purchase order forms with a purchase order number. 
Detailed order requests on signed company letterhead are also accepted. All orders are subject to credit 
approval. Please include a completed Order Form with your purchase order and fax it to 1-860-429-3542 
or mail it to:

WinZip Computing, Inc.
PO Box 540
Mansfield, CT 06268 USA



German, French, and Japanese Versions
There are German and French language versions of WinZip®.    For Japanese users there is an English 
version with the Help file in Japanese.    Prices for these versions may vary from the prices for the English 
language version as purchased from WinZip Computing, Inc.

German Version: For a German language version of WinZip, please contact H.C. Top Systems, B.V., 
Postfach 13 30, D-47630 Straelen, Germany, phone: 08000-946-947 (toll free; Germany only) or +31-(0)-
77-306-8100, fax: +31-(0)-77-306-8130, visit their web site or send e-mail to support@winzip.de.

French Version: For a French language version of WinZip, please contact AB Soft, Park Burospace #14, 
91572 Bievres Cedex, France, phone: +33-(0)-1-69-33-7050.

Japanese Users: For a version of WinZip that includes a Japanese Help file, please contact P. & A. Inc., 
Fudoya Bldg 4F, 2-10-1 Akebono, Tachikawa, Tokyo, Japan 190-0012, phone: +81-(0)-42-525-9501, fax: 
+81-(0)-42-525-9502, e-mail: info@panda.co.jp.    P. & A. also maintains web sites in Japanese and in 
English.



Why aren't WinZip's e-mail features working for me?
WinZip® support for e-mailing archives requires that you have an e-mail program installed and properly 
configured. If there is a problem with your e-mail configuration, then these features will either be disabled 
or nonfunctional.

WinZip uses a Windows feature called MAPI (Mail Applications Program Interface) to "talk" to your e-mail 
program. MAPI is a standard interface that allows WinZip and other programs to instruct your e-mail 
program to create a new message, attach a file to it, etc.    If MAPI is not properly configured on your 
system, then WinZip and other programs can't create e-mail for you.    "Properly configured" means that:

· you have a MAPI-compliant e-mail program installed, and
· the e-mail program properly supports the "Simple MAPI" interface that WinZip requires, and
· the e-mail program is configured to be the default e-mail program (sometimes called the "default 

MAPI client").

Examples of popular MAPI-compliant e-mail programs include (but are not limited to) Outlook, Outlook 
Express, Eudora, and AOL 7.0.

AOL versions 4.0, 5.0, and 6.0 are not MAPI-compliant and therefore do not support WinZip's e-mail 
features.

If you are having difficulty e-mailing your archives with WinZip, we have tips for some popular 
configurations available on our website.    Please visit http://www.winzip.com/xmapi.htm.



The WinZip Quick Start Guide
This Quick Start Guide introduces some file compression terms, describes some of the initial steps in 
installing WinZip, and provides a first look at using some WinZip® features. For additional information, 
see the tutorials that come with WinZip, WinZip help, and visit the WinZip web site at 
http://www.winzip.com.

What is an Archive or Zip file, anyway?
Zip files are "archives" used for storing and distributing files, and can contain one or more files.    Usually 
the files "archived" in a Zip file are compressed to save space. Zip files are often used to:

· Distribute files on the Internet: Only one Zip file transfer operation (download) is required to 
obtain all related files and file transfer is quicker because the archived files are compressed.

· Send a group of related files to an associate: When you distribute the collection of files as an 
archive you benefit from the file grouping and compression as well.

· Save disk space: If you have large files that are important but seldom used, such as large data 
files, simply compress these files into an archive and then unzip (or "extract") them only when 
needed.

What does WinZip do?
WinZip makes it easy for Windows users to work with archives.    WinZip features an intuitive point-and-
click drag-and-drop interface for viewing, running, extracting, adding, and deleting files in archives with a 
standard Windows interface, and also provides a Wizard interface that further simplifies the process of 
working with Zip files.

About WinZip's Setup Options
During the WinZip setup procedure you are asked to select either the WinZip Wizard interface or the 
WinZip Classic interface.

· WinZip Wizard: If you are new to computers, or unfamiliar with the Windows operating system, 
then you should first try using the WinZip Wizard to open and create your Zip files.

· WinZip Classic: The more powerful WinZip Classic interface is recommended if you are an 
experienced computer user, comfortable with using Windows and Zip files.

In the following section we will describe the WinZip Wizard Setup screens. With either interface, the setup
panels provide information about the options offered. Whichever setup option you choose, you can easily 
switch between the two interfaces at any time with a single click, and you can always change the default 
settings later.

Installing the WinZip Wizard
We will refer to the on-screen panels using the title that appears at the top of each panel.    

1. In the WinZip Setup panel, choose Start with the WinZip Wizard and click Next. The Search for 
Favorite Zip Folders panel will appear.

2. In the Search for Favorite Zip Folders panel, choose Search Entire Hard Disk so the Wizard can
search your system for Zip files (this is the recommended option).    You will see the search 
progress, and then a panel that says something like "17 folders were added to your 'Favorite Zip 
Folders'".    Click Next. 

3. The WinZip Wizard Setup is complete panel displays. Click Next to continue, and the Wizard 
Welcome panel will appear.

4. In the Wizard Welcome panel, click Next again, and the Select Activity panel will appear.

That's it, you have installed WinZip, and you're ready to begin using the WinZip Wizard. The sections 
below describe using the Wizard for unzipping and zipping files.



Using the WinZip Wizard
If you have just installed WinZip and selected the WinZip Wizard interface, then at this point the Select 
Activity panel is on the screen.

If you have previously installed WinZip, you can start a WinZip session using the WinZip program item in 
the WinZip program group, the Start menu, or the WinZip icon on your desktop.

Here is a brief introduction to the features of the WinZip Wizard.

Quick Unzipping with the WinZip Wizard
1. In the Select Activity panel, choose Unzip or install from an existing Zip file and click Next. 

The Select Zip File panel will appear. 
2. In the Select Zip File panel, click on the Zip file you want to work with and click Next. The Unzip 

panel will appear.
3. In the Unzip panel, click Unzip Now to open the files in the archive. The WinZip Wizard will open 

a Windows Explorer window showing the unzipped files.

That's it, you've just unzipped (extracted) a Zip file using the WinZip Wizard. You can now work with the 
unzipped files, or click Next to choose another activity within WinZip, or close the WinZip Wizard window.

Quick Zipping with the WinZip Wizard
1. In the Select Activity panel, choose Create a new Zip file and click Next.
2. In the Choose Zip Name panel, type the name you want to use for your new Zip file and click 

Next. For example, if you are creating a Zip file that will contain some files related to monthly 
reports, you might type “June reports” as the name for your Zip file.

3. In the Select Files panel, click Add files to add files to your Zip file, then select the files you want 
to add and click OK.

4. Click Zip Now to create the new Zip file.

That's it, you've just created a Zip file using the WinZip Wizard. You can now click the WinZip Classic 
button if you would like to examine the contents of your new archive, or click Next to choose another 
activity within WinZip, or close the WinZip Wizard window.

Using WinZip Classic
Here is a brief introduction to some of the features of WinZip Classic.

Quick Unzipping with WinZip Classic
1. In the WinZip Window click the Open toolbar button, or choose Open Archive from the File 

menu. The Open Archive dialog box will appear.      
2. In the Open Archive dialog box you can locate the archive you want to unzip. Then click Open. 

The contents of the archive will be displayed in the WinZip window.
3. To extract files from the archive click the Extract toolbar button, or choose Extract… from the 

Actions menu. The Extract dialog box will appear. 
4. In the box labeled Extract to: choose the folder where you want to place the extracted files and 

click Extract.
That's it, you have extracted the contents of the archive to the chosen directory. You can now work with 
the extracted files, or choose another activity within WinZip, or close the WinZip window.

Note: You can also extract files from an archive in the WinZip Classic window by dragging them to the 
desired folder in Windows Explorer or to the desktop.

Quick Zipping with WinZip Classic
1. In the WinZip Window click the New toolbar button, or choose New Archive from the File menu. 

The New Archive dialog box will appear.      



2. In the New Archive dialog box you can specify the location where you want to create the archive, 
and type the name you want to use for your new archive. Then click OK. The Add dialog box will 
appear.

3. In the Add dialog box select the files that you want to add to your new archive and click Add.

That's it, you have created a new archive. You can now examine the contents of your new archive, or 
choose another activity within WinZip, or close the WinZip window.

Note: You can also add files to an archive by dragging the files from My Computer or Windows Explorer 
and dropping the files on the WinZip window.

WinZip Classic and Wizard: Switching Interfaces
You can easily switch between the WinZip Wizard and WinZip Classic Interfaces with a single mouse 
click. Here's how:

In WinZip Wizard click the WinZip Classic button at the lower left part of the Wizard panel to switch to 
the WinZip Classic Interface.

In WinZip Classic click the Wizard button at the upper right end of the WinZip Classic toolbar to switch 
to the WinZip Wizard Interface.

WinZip Classic Tips
You can view the contents of most files in an archive by just double clicking on them in the WinZip Classic
window.

You can extract files from an archive in the WinZip Classic window by dragging them to the desired folder 
in Windows Explorer or to the desktop.

Using the WinZip Classic Help menu, you can:
· work with the built-in Brief Tutorial to get acquainted with more of WinZip's features 
· view collections of Hints and Tips 
· find answers to Frequently Asked Questions

Zip and Unzip Files without Leaving Explorer
To create an archive: you can select file(s) in Windows Explorer, right click, and choose Add to Zip file 
from the context menu that appears. 

To extract files from an archive: you can select the archive in Windows Explorer, and either: 
· right click and choose Extract to... from the context menu that appears, or 
· right click and drag the archive onto the folder where you want it extracted, and then choose an 

extract option from the context menu that appears.

Contacting Technical Support
You can contact our technical support staff as follows:

Internet: The best way to report problems on the Internet is with the support forms available from the 
“Support” link on the WinZip home page at http://www.winzip.com. You can also send electronic mail to 
support@winzip.com.    We normally answer all questions within one business day. 

Postal Mail:    Write to Technical Support, WinZip Computing, Inc., P.O. Box 540, Mansfield, CT 06268, 
USA. 

Please include the following information with any technical support questions: 
· Is the problem reproducible? If so, how?
· What version of Windows are you running (for example, Windows Me or Windows 2000)?



· What version of WinZip are you running? If you are using the WinZip Classic Interface, choose 
About WinZip from the WinZip Help menu. If you are using the WinZip Wizard Interface, click the
About button on the WinZip Wizard Welcome screen. Please include the entire "version" line in 
your problem report.

· If a dialog box with an error message was displayed, please include the full text of the dialog box, 
including the title in the title bar.




